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Introduction 

A word processor is a computer program that allows you to create, edit and produce text 

documents, such as letters. The first version of Microsoft Word was released in 1983 as a competitor 

to WordStar, the most popular word processor at the time. 

What Microsoft Word means?  

Microsoft Word or MS Word (often called Word). It is a graphical word processing program 

that users can type with. Its purpose is to allow users to type and save documents. It is one of the many 

applications that are grouped under the Microsoft Office umbrella. 

What is Microsoft Office used for? 

Microsoft Office is a suite of applications designed to help with productivity and completing 

common tasks on a computer. 

Microsoft Word for Windows release history 

Year 

released 
Name Version Comments 

1989 Word for Windows 1.0 1.0  

1990 Word for Windows 1.1 1.1  

1990 Word for Windows 1.1a 1.1a  

1991 Word for Windows 2.0 2.0 Included in Office 3.0 

1993 Word for Windows 6.0 6.0 32-bit version for Windows NT only. 

Included in Office 4.0, 4.2 and 4.3 

Skipped 3, 4 and 5. 

1995 Word for Windows 95 7.0 Included in Office 95 

1997 Word 97 8.0 Included in Office 97 

1998 Word 98 8.5 Included in Office 97 

1999 Word 2000 9.0 Included in Office 2000 

2001 Word 2002 10.0 Included in Office XP 

2003 Microsoft Word 2003 11.0 Included in Office 2003 

2006 Microsoft Word 2007 12.0 Included in Office 2007 

Released to businesses on Nov 30, 2006. 

Released to worldwide to consumers on Jan 30, 

2007. 

Extended support until Oct 10, 2017. 

2010 Word 2010 14.0 Included in Office 2010 

Skipped 13.0 

2013 Word 2013 15.0 Included in Office 2013 

2016 Word 2016 16.0 Included in Office 2016 

2019 Word 2019 16.0 Included in Office 2019 

 

And it’s had in different platforms like: Mac OS, MS-DOS, SCO Unix, etc. 



Author: BDM 

 

3 
 

Don’t use in public Don’t Copy 

Exploring the Word 2016 Enviroment 

Title Bar 

 

Quick Access Toolbar 

     1  2          3         4        5 

1. Use it to open the saving file [Ctrl+O]. 

2. Use it to save your active document [Ctrl+S]. 

3. To be back off your error, use undo [Ctrl+Z]. 

4. Redo/Repeat [Ctrl+Y]. 

5. Customize Quick Access Toolbar. 

 

        1                2               3              4 

1. Ribbon Display Options. 

2. Minimize. 

3. Restore Down (full screen size to small screen size) and  

    Maximize (small screen size to full screen size). 

4. Close (Close the whole word, not only document). 

 

 

 

Active Tab. By default, it will open with the Home Tab active on the ribbon. The active tab has a 

different color. 
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Contextual Tab. These tabs are displayed when certain objects, such as an images and text boxes, 

are selected. They contain additional options for modifying the object. 

1. Ruler Bar. You can see and set tap stops, move table border and line up object in the 

document. Also, you can measure stuff. It have horizontal ruler and vertical ruler. 

2. Insertion Point. It was showed to type. 

3. Work Area. 

4. Scroll Bar. To make work area up or down. 

5. Zoom Tools. 

6. View buttons. 

7. Page Info & Word Count. 

8. Tab Selector. 

 

 

 

 

 

 

 

 

1 

2 

3 

4 

5 

6 7 

Ribbon Group 

Dialog Box Launcher 
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Information 

Protect Document. When you are finishing a document 

and send it to a person. Only that person can open this 

document by knowing password. 

 

 

 

 

 

Inspect Document. Before publishing this file, you 

can check your issues to be correct. 

 

 

 

 

Manage Document. Check in/out and recover unsaved 

changes in your daily working file. 
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New In this way, you can make a new document but this is not for a new page. If you have the 

internet, you can search for online templates. [Ctrl+N] 

Open 

When you want to open a 

document, you have to know 

where did you save it (means 

location). [Ctrl+O] 

 

Save & Save As If you want to save a new 

document, you need to go to the Save As. Select your 

location type, give a name and save. [Ctrl+S] 

 

 

 

 

  

To save in local computer, double click 

on it. 

Choose 

Location 

Displays file 

paths 
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Print 

Print settings will help you to print your 

document. You can manage your paper 

by analyzing it in Page Setup (below the 

button). [Ctrl+P] 
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This closure will not close the entire Word situation, but only the currently used document. 

Word Options  

We can manage about User in General Setting. Display Setting will help us how document content is 

displayed on the screen and when printed. We can change how Word corrects and formats your text in 

Proofing Setting. We can customize how documents are saved and also language. We can edit and 

manage on advanced options for working with Word. We also have Customize Ribbon, Quick Access 

Toolbar, Add-ins and Trust Center. 
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Home Tab 

Using Clipboard Group 

1. Select the text first and click Copy [Ctrl+C]. Take the insertion point to the 

place you want and click Paste [Ctrl+V]. 

2. Select the text first and click Cut [Ctrl+X]. Take the insertion point to the place you want and 

click Paste [Ctrl+V]. 

3. You have some effect on our text and you want to put it on another text. To get the effect; Select 

the text first and click on the Format Painter. You can use it once with just one click, but you can 

use it more with two clicks}. Then choose another text to get the same effect. 

By clicking Dialog Box Launcher, it will show the effect in the box next to your left screen. 

-------------------------------------------------------------------------------------------------------------------------

Using Font Group 

 

Click the Font Dialog Box Launcher on 

the Font Group to open font box. Here you 

can further manage. 

-------------------------------------------------- 

 

Font 

In/Decrease Size 

Change Case 

Clear All Formatting 

Bold [Ctrl+B] 

Italic [Ctrl+I] 

Underline [Ctrl+U] 

Strikethrough 

Subscript [Ctrl+=], Superscript [Ctrl++] 

Text Effects and Typography 

Text Highlight Color 

Font Color 
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Font 

You can choose a new font for your text. Not all fonts are here. You can go to the browser and install 

the font you want. Which font do you want to use? You must first have it on your machine to use it. 

Size 

If you use Increase Size, you can only use the size from your device. For example, there are 12 and 

14, but not 13. The same goes for Decrease Size. So if you want 13 size, you have to do it yourself. 

Change Case 

Change Case can help you to change your words or sentences. For example, Happy, happy, HAPPY 

and hAPPY. 

Clear All Formatting 

Remove all formatting from the selection, leaving only the normal, unformatted text. If you want to 

use it, you must select your text first and click on it. 

Bold 

The font you write is thin. Then you want to make it thick. So first select your text and click on Bold. 

Then you will see that your text is thick. 

Italic 

Select your text and click Italic. It will italicize you text. 

Underline Style 

Underline style will help you to underline your text. To be used, select your text and click on it. 

Strikethrough 

For example, drawing through a line in your text to show it as an error. Select your text and click it. 

Subscript & Superscript 

When you type a date or some mathematical equation. You want to move up or down a bit. Use 

Superscript to go up and use Subscript to go down. 
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Text Effects and Typography 

Add some flair to your text by applying a text effect, such as a shadow or glow. You can also change 

the typography setting to enable ligatures or choose a stylistic set.  

Text Highlight Color 

Make your text pop by highlighting it in a bright color. 

Font Color 

Change the color of your text. 

------------------------------------------------------------------------------------------------------------------------- 

Using Paragraph Group 

 

 

 

If you use Left Alignment, your content will reach the left of the page. 

If you use Center Alignment, your content will reach the center of the page. 

If you use Right Alignment, your content will reach the right of the page. 

If you use Justify Alignment, Your content will be aligned on both sides of the page. 

Left [Ctrl+L], Center [Ctrl+E], Right [Ctrl+R] 

Justify [Ctrl+J] 

Line and Paragraph Spacing 

Shading 

Borders 

Sort 

Show/Hide enter sign [Ctrl+*] 

Decrease/Increase Indent 
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Line and Paragraph Spacing. Choose how much space appears between lines of text or between 

paragraphs. To apply the same spacing to your whole document, use the Paragraph Spacing Option on 

the Design Tab. 

Shading 

Change the color behind the selected text, paragraph or table cell. This is especially useful when you 

want information to jump off the page. 

Border It helps to change the shape of the frame in your table or remove it. 

Show/Hide enter sign is especially useful for advanced layout tasks. 

Decrease Indent Move your paragraph closer to the margin. 

Increase Indent Move your paragraph farther away from the margin. 

 

To find bullets style – 

Symbol,       

Wingdings, 

Wingdings2,                 

Wingdings3, 

Webdings, etc. 

 

 

We can use different number style and add something to it. We 

can change font, size and color. But cannot change font in 

Bullets style. 

-------------------------------------------------------------------------- 

 

 

 

 

Bullets, Numbering and Multilevel List 
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You can find words by using Find [Ctrl+F]. If you want to find and replace [Ctrl+H] some word, use 

Advanced Find. If you want to go somewhere, use Go To [Ctrl+G].  

By using Select, you can select all or only Objects that you want. And you can 

display the Selection Pane. 
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Insert Tab 

Using Pages Group 

If you want to make cover design for a book, you can use Cover Page. Cover 

design can be easily created. Blank Page and Page Break help you get a new 

worksheet. 

Using Table Group 

 

Using Illustrations Group 

Pictures & Online Pictures 

Insert Pictures will 

help you take pictures from 

your computer or another 

computer you are connected 

to. If you do not have a 

picture, you can use Online 

Pictures to find some of the 

pictures you want. But you 

need an internet connection.  

Shapes 

You can use Shapes to easily draw the shapes you want. You can easily get shaped like heart shape, 

Circle shape, Square shape, etc. 

 

A table is a great 

way to organize 

information within 

your document. 

This will help you to make easy 

Table. But have only 10 x 8 Table. 

If you want a lot 

of columns and 

rows, you can 

use Insert Table. 

You can create 

Table size and 

AutoFit 

Design your own table by 

drawing the cell, row and 

column borders yourself. You 

can even draw diagonal lines 

and cells within cells.   
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SmartArt 

The SmartArt feature lets you create and 

customize designer-quality diagrams to convey 

information with graphics instead of just text. 

You can even convert bulleted lists into a 

diagram using the SmartArt diagram tools. 

Chart 

You can make a chart in Word. If you 

have lots of data to chart, create your chart in 

Excel, and then copy from Excel to another 

Office program. This is also the best way if your 

data changes regularly and you want your chart 

to always reflect the latest numbers. In that case, 

when you copy the chart, keep it linked to the 

original Excel file. 

To create a simple chart from scratch in 

Word, click Insert > Chart, and pick the chart you 

want. In the spreadsheet that appears, replace the 

default data with your own information. 

Screenshot 

A screenshot includes all the elements currently on the screen, including the Word toolbar 

and any items present in the document. Screenshots are also editable directly within Word as well as 

in graphic manipulation programs. 

Using Header & Footer Group 

Header will help you to make a title from the top of 

your page. This will make you easy to add title all pages. 

Footer also can do that at the bottom of your page. You can 

add custom characters or dates. Page Number will help you 

to number the pages in your document. It can be easily edited 

or removed. 
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Using Text Group 

Text Box 

A Text Box brings focus to the content it contains and is great for showcasing important text, 

such as headings or quotes. You can also draw by using Draw Text Box.  

Quick Parts 

Quick parts, also referred to as “building blocks,” are frequently used text saved in a gallery, 

from which it can be inserted quickly into a document. Recycle content in business documents by 

creating and using building blocks. 

WordArt 

WordArt is a gallery of text styles that you can add to your publications to create decorative 

effects, such as shadowed or mirrored (reflected) text. You can use WordArt to add special text effects 

to your document. ... You can modify or add to the text in an existing WordArt object whenever you 

want. 

Drop Cap 

A drop cap (dropped capital) is a large capital letter used as a decorative element at the beginning of a 

paragraph or section. The size of a drop cap is usually two or more lines. The following illustration 

shows your options for positioning a drop cap.  

 

 

 

 

 

 

Equation & Symbol 

You can create your own equations using the library of math 

symbols and structures. Symbol will help you to choose a variety 

of options including mathematical, currency, and copyright 

symbols. 
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Design Tab 

Using Page Background Group 

 

 

 

 

 

 

 

A watermark is an image or text that appears behind the main text of the document. It is usually a 

lighter shade than the text, so you can read the document easily. 

 

 

 

 

 

 

In MS Word there is a special feature called Page Color in which you can add color to the pages of 

your document. 

 

 

 

 

 

 

 

A border draws focus and add a stylish touch to your document. You can create a border using a variety 

of line style, widths and color, or choose an art border with a fun theme.  
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Layout Tab 

Page Setup was the same as print. Margins will help you to 

manage sizes for the entire document or the current section.  You can 

give your pages a portrait or landscape layout. Choose your paper 

size for your document and it will help you when printing.  

Columns 

Essential to formatting many documents, columns help break up the layout of a page full of text. You 

can set columns just about any way you like with the ability to specify the number, size, and borders.  

 

 

 

 

 

From the giving Paragraph Group, you can manage your paragraph’s indent and spacing. After 

you bring a photo or something into your passage, you can arrange it to use backward, bring forward 

or using wrap text.  

 

 

 

 

Position 

Text will automatically wrap around the object so that it’s still easy to read. 

Wrap Text 

You can choose to have the text continue around the object or cross right over it. 
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References Tab 

Table of Contents will provide an overview of your document by 

adding a table of contents. Text using a heading style will be included 

automatically. To include more entries, select the text and click add text. 

The table will be refreshed when you click update table.  

Insert Footnote (Ctrl+Alt+F) Add a note at the bottom of 

the page providing more information about something in your 

document.  

 

 

Review Tab 

Add a note this part of the document. For example, 

you write a word “TTC Student” and you want to note 

something about it. So, you select that text and make a New 

Comment. After that you write on it like “This is only for 

student.” You can use Show Comments to see your note 

and you can also delete it. 

 

View Tab 

You can change your view like Read Mode, Print Layout, Web Layout or Outline. Page 

Movement will show your page is vertical or side to side. If you click Ruler, Gridlines or Navigation 

Pane that will show you. Zoom can change your viewing page size.  
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Exercise (1) 

 

Techopedia Explains Computer System 

Early Models 

To look at the history of a computing system, you have to go all the way back to Charles 

Babbage’s differential machine. This computer, (which never actually got fully built), predated and 

prefigured the mainframes and large-scale computers of the early 20th century the Von Neumann 

machine and its ilk, as computers, bulky and monolithic, first appeared in the human world. 

The Personal Computer 

Then, the personal computer or desktop computer was born. This model persisted for a long time, 

where the computer box or shell was the central hardware and used peripherals like a monitor, 

keyboard and mouse, along with software that was fed to the computer through floppy disks. 

OPERATING SYSTEM 

The operation system emerged early as a convention in supporting the full computing system 

in the box, and making sure that users had a universal way to handle the software that ran on 

that hardware. Then, in addition to the operating system, we learned about files, applications, 

and executables, the actual software products delivered to run on a given operating system. 

Laptops 

Over time, as Moore’s law continued to apply and hardware became smaller, the laptop 

computer was born. Then came the mobile phone, and eventually the peripheral interface model with 

the plugged-in mouse, keyboard and monitor was replaced by a single touch screen device, so that no 

peripherals were needed. 

The Cloud 

At the same time, a key software advance applied, too. Cloud and software as a storage models 

meant that software came to be delivered digitally through the Internet, instead of being sold 

on physical media like floppy disks and later, compact discs. “Out of the box” software became 

somewhat obsolete, especially in enterprise IT. 
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Exercise (2) 

 

Virtualization 

More recently, virtualization revolutionized how we think of hardware and software setups. A 

modern computing system may not consist of a piece of hardware itself – it may instead consist of a 

virtualized computer system or virtual machine that uses resources from a grid to operate. 

So, what we think of as a computing system has changed in form, but not, in key ways, in substance. 

It still has all of those core capabilities: receiving user input, processing data, and storing information 

– it just does them in much more elegant and capable ways. 

As the interface evolves, and as we approach a new world of AI and machine learning, we see what 

power computing systems can have. 

 

MICROSOFT OFFICE COURSE – 

 Microsoft Word 

 Microsoft Excel 

 Microsoft PowerPoint 

 Internet & E-mail 

 

Graphic Design Software Course – 

[i] Adobe Photoshop 

[ii] Adobe Illustrator 

[iii] CorelDRAW 

[iv] Paint & 3D 
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Exercise (3) 

Hawk Happenings 

It has been a busy fall at 

the Hawks’ nest. The 

Intermediate Hawks finished 

with a silver medal in co-ed 

soccer and the Intermediate 

Girls X-Country running team, 

who had a tremendous season, 

came home with 1st and 2nd 

finishes in the city final race. 

In the secondary 

program, Cayley Barbeau 

qualified for the Northern 

Ontario championships in 

Golf. Jaxson Cress finished 

with the bronze medal in both 

the City championship and 

Northern Ontario 

championship x-country races 

and Ben Ligandin finished with 

a gold medal in both the City 

championship and Northern 

Ontario championship races. 

This finish qualified Ben to run 

in the all-Ontario 

championship race.

We also had a tremendous 

season on the volleyball and 

basketball courts making it 

to playoffs in both of these 

sports. And thein there is 

football. Lively had another 

exceptional football season. 

The Lively Girls Flag 

Football team was regular 

season, Division A champs 

with 4 out of 5 wins. With 

152 points in the regular 

season and only 71 points 

against, the girls fought a 

hard battle to stay on top in 

the semifinals, losing to 

Notre Dame after a field 

goal kick with 10 seconds 

left in the game.

The Senior Boys Football team 

finished the regular season at 5 

– 1 finishing the league play in 

2nd place. The team defeated 

St. Charles in the semifinals, 

however lost against Lo-Ellen 

in the City championship 

match. Most say that this final 

game between Lively and Lo-

Ellen (a rematch of last year’s 

finals) was arguably the best 

football final in the last 20 

years. 

  

All Of Us At The Sudbury District Nurse Practitioner Clinics 

Wish You A Happy And Safe Holiday Season. 
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Exercise (4) 

 

Examination Status For L5DC Section Result 

 No Student Name GC MOC DTP Status 

 1 Su Aye Aung 82 66 70 Pass 

 2 Nyein Maung 75 82 76 Pass 

 3 Min Min 50 42 35 Fail 

 4 Poe Aung Aung 80 43 52 Fail 

 5 Thiri Tun 76 80 90 Pass 
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Exercise (5) 

 

Unfortunately, the Lively boys lost to the Sault Ste. Marie team 14-0. 

The boys will never forget this game as it was played in a foot of snow 

and blizzard like conditions. With over half of the school population 

playing football this year, the Lively football program has blossomed 

thanks to our dedicated and talented students, past and present who make 

an effort to support and represent our fantastic school. A special thank you goes out to the coaches, 

especially the community coaches, for giving of your time to work with our Hawk athletes. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  

PowerPoint

Excel

word
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Exercise (6) 

 

 

 

 

 

 

 

The manager should have 

full expertise for this job as 

he needs to manage all the work processes of the employees. The instructor will need to energy and flexibility 

as every class will have employee’s whose skill level in Microsoft Word will span for the novice to proficiency level. 

  

Course Fees Discount List 
Class A Class B Class C 

Internet & E-mail 100 MYOB Level 1 200 DTP Course 380 

Computer System 900 MYOB Level 2 300 ICT Foundation 400 

Office Course 380 Auto CAD 410 Database 390 

Advance Course 420 Graphic Design 450 Linux 600 

Advance Excel 210 Web Application 200 NE + 920 

Total  Maximum  Average  

No Name Employee Number Post Salary 

1 Mr. Jame BTI – 2001 Manager 4200 

2 Mrs. Yin BTI – 2002 Senior Manager 3890 

3 Mr. Moe Thein BTI - 2003 Instructor 3000 
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Exercise (7) 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  

OCTOBER 

M T W T F S S 
      1 

2 3 4 5 6 7 8 
9 10 11 12 13 14 15 

16 17 18 19 20 21 22 
23 24 25 26 27 28 29 
30 31      

ITEM NEEDED 

Books 23 

Magazines 14 

Notebooks 0 

Paper pads 3 

Pens 5 

Pencils 2 

Ruler 3 

A birthday wish is sent your way hoping you’ll have a wonderful 

day. Surrounded by people you hold most dear, gathered to celebrate one 

more year. A happy day is wished for you, I hope it lasts the whole year 

through! 

Your Lovely, 
Boom 

Some People look down upon good manners as being only surface of 

fessing and having no real value. Theay think that to be polite is tube 

womanish. It may be true that soft, smooth speech may hide a 

deceitful heart. But it is equally true that a rough, rude manner may 

hide a kind heart so effectively that no one cannot discover it. 
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KNU Font Layout 

Normal Typing 

` 1 2 3 4 5 6 7 8 9 0 - = 

q w e r t y u i o p [ ] \ 

 

a s d f g h j k l ; '  

z x c v b n m , . / 

 

Using Shift 

~ ! @ # $ % ^ & * ( ) _ + 

Q W E R T Y U I O P { } | 

 

A S D F G H J K L : "  

Z X C V B N M < > ? 

 

Example; 

 

eD>q.*hRzD 

pDR'g'D 

w>b.,GRto; 

euvJRzJvJ.A,uvJRydmecH 
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Exercise (8) 

 

vgtD;uxdbX.A(1)oD<A2023eH.<Ark>her'd.<A*DRw>bg 

t*h>'ftHRepkqSX,R 

,&Sg,R A41;13<A?t*h>'ftHR<A,J'.,GReup>tHR,[H;CmepkxGJ<A 'D;pH;vXeR<A ysHRw>w*hR<A 

,rRpXRvHeRvHI”  

vHm,&Sg,R(41;12=31)Aw>*h>vXtymzsg0JM.rh>0J<A?up>,GRvXyxd.o-wDRtDR'D;ySR*Rwoh0J” 

At*h>M.vDRIA,GRtySR*D>rk>tH.p&hv;zdu[JuhRb.qltxHtuD>'.0Jt*D>Arh>rwRw*RvXtol.'h'DA 

to;'h'D0Jtd.w*RM.{gIAySRuGJ;xgpH;y-wXRteD>up>'.0JnduGHm0JySRvXto;'h'D0Jwz.M.vDRIA 

t*h>'ftHRAup>,GRvXtwhvDRymvDRw>w*RM.rh>rwRw*RvXtu}wDtDRohw*RvJ.IA   t0J'.rh>up> 

up>vXAtohw>vXm'D;trRw>cJvXmAM>oh0J'.cJvXmM.vDRI(12=19)IA ow;'D;,GRvXtrl0J 

vDRxlvDR,dm tcX.p;A rh>rwRw*RvXtoguwhxD.w>*DR'D;emtDRM.w*RvJ.IA w>'ftHRod;M.A 

rh>0Jw>vDRrJmqS;M.vDRI AyysHRbRblRvd.tup>,GRvXtrh>w>*DRw>zD.M.tvD>wtd.b.0JM.vDRI 

A(18=20)IAt*h>'ftHR<Ay,GRyup>rh>up>vXtwhvDRw>ud;rHR'J;'D;yX0JySRuvkmuvkmwz.A 

vX[D.cd.csXcJvXmM.vDRI A'D;t0Joh.tup>vXtbg0JM.AvX,GRtrJmngvDR*mr;'fAwX>zdwz.tod;A 
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